
U.S. FEDERAL AVIATION ADMINISTRATION
OFFICE OF AVIATION MEDICINE

 ENCYCLOPEDIA OF MEDICAL
PROGRAM DATA

CD-ROM

USER MANUAL

1/22/97



2

ACKNOWLEDGEMENTS

Screen prints from Adobe Acrobat Reader with Search software are
Copyright Adobe Systems, Inc.

Text items (Italicized and bolded) describing Adobe Acrobat Reader
with Search software are Copyright Adobe Systems, Inc.

Screen prints from Dataware CD-Answer  software are Copyright
Dataware Technology, Inc.

Text items (Italicized) describing  CD-Answer  software are Copyright
Dataware Technology, Inc.

This User Manual was prepared by:

Eugene B. Leiderman
Computer Specialist
U.S. Federal Aviation Administration
AAM-110, Room 806
800 Independence Ave., S.W.
Washington, D.C. 20591

202-267-3544  (phone)
202-267-5219  (fax)

E-mail:    Eugene.Leiderman@faa.dot.gov
.



3

TABLE OF CONTENTS

I.  Background ..................................................................................................  5

A.  General ............................................................................................  5
B.  Computer Requirements .................................................................  5

1.  Hardware .............................................................................  5
2.  Software ...............................................................................  6

C.  Installation Procedures ...................................................................  6
D.  Documentation ................................................................................  7

1. Encyclopedia of Medical Program Data User Manual .........  7
2.  Encyclopedia of Medical Program Data-- ............................  7

                                     Adobe Acrobat Reference Manual
3.  Encyclopedia of Medical Program Data-- ............................  7

                                     CD Answer Reference Manual
E.  Running the Software ...................................................................... 7

1.  Procedures ..........................................................................   7
a.  ACROBAT READER WITH SEARCH Application..  8
b.  CD ANSWER Application ........................................ 9

2.  Windows Context-Sensitive HELP ...................................... 10

II.  Text Searching:  ADOBE ACROBAT READER WITH SEARCH ............... 10

A.  Information  Content ....................................................................... 10
B.  Windows Operations ........................................................................ 11
C.  Welcome Files .................................................................................. 11

1.  Encyclopedia of Medical Program Data .............................. 11
a.  Welcome File Contents ........................................... 12
b.  Information Contents ............................................. 12

2.  Encyclopedia of Medical Program Data User Manual ....... 14
3.  Encyclopedia of Medical Program Data Adobe Acrobat  .... 14

                                     Reference Manual
4.  Encyclopedia of Medical Program Data CD Answer ........   14

                                      Reference Manual
D.  Acrobat Reader Window ...............................................................   15
E.  ACROBAT READER WITH SEARCH Menus ...............................  16
F.  ACROBAT READER WITH SEARCH Program Functions: ..........  17

                       Toolbar
G.  Indexes ...........................................................................................  19
H.  Application Functions ....................................................................  23

1.  Scan Individual Documents ...............................................  23
2.  Search Text ......................................................................... 23

a.  Search Individual Documents ................................ 23
b.  Global search (all documents): ............................... 23

                                                Sample Global Search
c.  Starting a Search ...................................................  28
d.  Using the Refine Search Feature ..........................  29

III.  Database (Fixed Field) Searching:  DATAWARE CD ANSWER .............. 29

A.  Information Content ....................................................................... 29
B.  Windows Operations ....................................................................... 29



4

C.  CD ANSWER Program Functions ................................................... 29
1.  Search ..................................................................................  30

a.  Search Window Menus ...........................................  30
b.  Search Window Toolbar  .........................................  31

2.  Display .................................................................................  33
a.  Display Window Menus ..........................................  33
b.  Display Window Toolbar .........................................  34

D.  Application Functions ...................................................................... 35
1.  Aviation Medical Examiners (AMEs) ................................... 35

a.  Search ......................................................................  35
(1)  Search Screen ............................................. 35
(2)  Formulating Search Queries ...................... 37

b.  Display Screens ........................................................ 38
2.  AAM Data Element Dictionary ............................................. 39

a.  Search Screen ........................................................... 39
b.  Display Screens .........................................................42

References:

          Encyclopedia of Medical Program Data CD-ROM

 Encyclopedia of Medical Program Data User Manual (this document)

  Encyclopedia of Medical Program Data --  Adobe Acrobat Reference Manual

   Encyclopedia of Medical Program Data  -- CD Answer Reference Manual



5

I .   BACKGROUND

A. GENERAL

The Encyclopedia of Medical Program Data CD-ROM contains various
publications, orders, directives, and other information deemed useful to
Office of Aviation Medicine personnel in the performance of their daily job
functions. This CD-ROM contains Office of Aviation Medicine and FAA
information which is searchable by words and terms and which contains the
most recent versions available for the various documents and information.

This Encyclopedia of Medical Program Data has been produced by the
Planning, Evaluation, and Information Resource Branch (AAM-110) of the
Office of Aviation Medicine using the services of the U.S. Government
Printing Office, Graphic Systems Development Division, Data Base Retrieval
Section, Washington, D.C.

Please contact the Office of Aviation Medicine, FAA, not the Government
Printing Office, with any comments or questions concerning this product.
Comments are welcomed and encouraged concerning content, ease of use, etc.
We encourage requests to include additional or updated versions of the
content. We anticipate updating and distributing this product periodically,
probably quarterly. Please contact Eugene B. Leiderman, AAM-110, by
phone, mail, or E-mail to discuss any matters related to this product.

The CD-ROM uses Adpbe Acrobat Reader with Search and Dataware’s CD
Answer search software in a Windows 3.1 environment.  It has several icons
in the Encyclopedia of Medical Program Data group. One icon access most of
the Office of Aviation Medicine and FAA documents for searching; a second
icon accesses AME DIRECTORY data; a third icon accesses a dictionary for
data elements used throughout the Office of Aviation Medicine as
documented by the Office of Aviation Medicine Data Architecture project; a
fourth icon accesses a readme file

B.  COMPUTER  REQUIREMENTS

1.  HARDWARE

o IBM PC or 100% compatible with 2MB free extended memory

o CD-ROM drive with appropriate controller and interface cable from any
CD-ROM drive with an ISO 9660 compatible device driver
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.
RAM:

o  4 MB RAM is required to run Acrobat Reader with Search.
o  4 MB RAM is required to run CD Answer for Windows.

HARD DISK STORAGE:

o You must have at least 6.5 MB of available disk space and at least 500K of
conventional memory to install and run Acrobat Reader with Search and
CD Answer for Windows.

MONITOR:

o A monitor that is supported by Windows.  Image support is currently
limited to EGA, VGA, SVGA, and VESA monitors.  Color support is currently
limited to VGA 16 color or VESA with 512K for 256 color.

PRINTER:

o Any printer supported by Windows may be used to print text from the
retrieval application.  In order to print images, you must have an HP
Laserjet printer with 1.5 MB or more of printer memory.

MOUSE:

o  A mouse that is supported by Windows.

2.  SOFTWARE

o  MS-DOS 3.0 or higher
o  Microsoft Windows 3.1 or higher
o  Microsoft Extensions (MSCDEX.EXE) to access the CD-ROM drive

RECOMMENDED:

o  For the best performance, the following configuration is recommended:

Load HIMEM.SYS (using the line DEVICE=HIMEM.SYS in your config.sys
file), and install SMARTDRV.EXE (using the line
INSTALL=SMARTDRV.EXE in your config.sys file).

C.  INSTALLATION PROCEDURES



7

1.  Start Windows
2.  Click on File
3.  Click on Run
4.  At the Command Line type
    n:setup  (n - is the CD-ROM Drive Letter)
    Select "OK"
5.  At the Winstall Message
    Select "OK" and answer the questions

D.  DOCUMENTATION

 The following  manuals are available on the Encyclopedia of Medical Program Data CD-ROM
to provide detailed information to assist the first-time user and the experienced user:

 1. Encyclopedia of Medical Program Data User Manual

This manual is a comprehensive overview containing the background, contents, and  instructions for using
the CD-ROM.  It ‘s intention is to provide the user with information to install the software and perform
basic, commonly used functions.  The following 2 manuals provide detailed information on uses of the
particular software package addressed with in-depth definitions and examples.

2.  Encyclopedia of Medical Program Data --  Adobe
Acrobat Reference Manual

This manual provides detailed information on the Adobe Acrobat Reader with Search software package.
This package performs searching of text material and permits reading of individual text documents.  The
manual thoroughly defines the software package’s Windows menu and toolbars and provides detailed
information with examples of how  to construct and use search requests.

3.  Encyclopedia of Medical Program Data  -- CD Answer
Reference Manual

This manual provides detailed information on the Dataware CD Answer software package.  This software
package performs searching on fixed field, database type information.   The manual thoroughly defines
the software package’s Windows menu and toolbars and provides detailed information with examples of
how  to construct and use search requests.

E.  RUNNING THE SOFTWARE

1.  PROCEDURES
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1.  Select (double click) Program Manager, if not already open.

2.  Select <ENCYCLOPEDIA OF MEDICAL PROGRAM DATA> group icon.

3.  Select <ENCYCLOPEDIA OF MEDICAL PROGRAM DATA> OR

               <AVIATION MEDICAL EXAMINERS DIRECTORY>OR

               <AAM DATA ELEMENT DICTIONARY> OR

               <EMPD USER MANUAL> OR

               <EMPD ADOBE ACROBAT REFERENCE MANUAL>OR

               <EMPD CD ANSWER REFERENCE MANUAL>

 a.  ACROBAT READER WITH SEARCH APPLICATION

 Select:   <ENCYCLOPEDIA OF MEDICAL PROGRAM DATA>

         The Welcome  file is displayed:

Select  “More” to continue reviewing the Welcome file; select “Click here for
the Information Contents” to see a list from which the user may select a
publication to individually review.  At any time the user may also perform a
global search of all documents as described below in Section II.H.2.b (global
searches).
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 b.  CD ANSWER APPLICATION

Select:
<AVIATION MEDICAL EXAMINERS DIRECTORY> or
           <AAM DATA ELEMENT DICTIONARY>

FAA Office of Aviation Medicine Logo is displayed:

To Continue, either
o  Click on the LEFT mouse button or Press any key   or

o  Wait about 10 seconds and the logo will disappear
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Next, the FAA Information Page is displayed:

To Continue, either
o  Click on the LEFT mouse button or Press any key

2.  WINDOWS CONTEXT-SENSITIVE HELP

CD Answer  and Acrobat Reader with Search both provide a context-sensitive
help.  Help is available at any time by pressing F1 Help.  The underlined
items may be accessed by clicking the mouse to access related topics on how
to use the system.

II.  TEXT SEARCHING:  ADOBE ACROBAT  READER WITH SEARCH

REFERENCE:  ADOBE ACROBAT  REFERENCE MANUAL

A.  INFORMATION CONTENT
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.The following items are available using Acrobat Reader with Search:

1.  Data Architecture Form Contents (Vol. 10-11) and Interview Notes
2.  AAM Strategic Plan
3.  Medical Guideline Letters (MGLs)
4.  Aviation Medical Examiner Guide (Includes Part 67)
5.  Federal Air Surgeon's Bulletin (1992-1996)
6.  Index of OAM Reports (1961-1996)
7.  OAM Telephone Directory
8.  AAM Orders and Directives
9.  OAM Research (RED) Program Book
10. Index of International Publications in Aerospace Medicine
11. Aeromedical Certification Division Statistical Handbook (Thru 1994)
12. Federal Aviation Regulations (FARS- Parts 61, 67, 121, 135)
13. Aviation Industry Substance Abuse Prevention Programs

     B.  WINDOWS OPERATIONS

The Windows software is used by (1) clicking on one of the various menu
options
available for sequentially scanning the contents of a document or (2)
performing successive searching functions to locate and view  desired
information using various forms of word searching.  Information is entered
into dialog boxes to execute the system functions.

C.  WELCOME FILES

       1.  Encyclopedia of Medical Program Data
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a.  Welcome File Contents

Click MORE to see the contents of the Welecome file, which describes the
project and provides some documentation.

b.  Information Contents

Click on the box labelled “Click here for the Information Contents.”  After
viewing a particular document, click on File/Close to return to the
Information Contents page.  This also applies to a single document search or
to a global search (icons Q and R, respectively, in the tool bar discussed
below).  Click on a specific document to view it or its table of contents (e.g,
MGLs, Orders, etc.).
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Select an item to view or perform a global search using the SEARCH
(binoculars on a page icon).  If viewing an item, the following screen
illustrates how the bookmarks and Status Window appear in the Acrobat
Reader window.

2.  Encyclopedia of Medical Program Data User Manual

Double click the  Encyclopedia of Medical Program Data User Manual icon
from the Windows group to access the document using the Acrobat Reader
with Search software.

3.  Encyclopedia of Medical Program Data Adobe Acrobat
Reference Manual

Double click the  Encyclopedia of Medical Program Data Adobe Acrobat
Reference Manual icon from the Windows group to access the document
using the Acrobat Reader with Search software.

4. Encyclopedia of Medical Program Data CD Answer Reference
Manual
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Double click  the  Encyclopedia of Medical Program Data CD Answer
Reference Manual icon from the Windows group to access the document
using the Acrobat Reader with Search software.

D.  Acrobat Reader Window

You open a document in the Acrobat Reader window. You can
display bookmarks or thumbnails in an overview area to the left of
the document.

Beneath the menu bar at the top of the window is the toolbar; at
the bottom left of the window is the status bar. At the right of the
window is a vertical scroll bar that enables you to scroll up and
down through a document. The overview area of the window
includes an independent scroll bar that you can use to scroll
through bookmarks or thumbnails.

Status bar fields and controls

The status bar contains the following fields and controls:
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The window splitter adjusts the width of the overview and
document areas. Drag the control to where you want to divide the
two areas.

The page number box displays the current page number and lets
you go to a specified page in a multipage document. Click the page
number box to display the Go To Page dialog box.

The magnification box displays the current page magnification
and lets you select various magnifications. Choose View/Other from
the menu to display the Zoom To dialog box.

Choose Preferences > General to set these options:

The page size box shows the size of the current page by using the
units specified in the Edit/Preferences/General dialog box.

E.  ACROBAT READER WITH SEARCH MENUS

NOTE:  Only the options used in this CD-ROM are documented here

   File                 Open and close applications,get
                                      information abut the current document,
                                      perform print and export operations,  and exit the
                                      program.

                Edit               undo, cut, copy, and paste , clear, select all, and
                                      preferences (general, full screen, search) operations.

               View               actual size, fit page, fit width, fit visible, full screen,
                                      zoom to, first page, previous page, next page, last page,
                                      go to page, go back, go forward, page only, bookmark and
                                       page, and thumbnail and page.

                Tools           hand, zoom in, zoom out, select text, select graphics,
                                       find, find again, search.

                Window         Hide tool bar, show clipboard, cascade, tile horizontally,
                                       tile vertically, close all.

                Help              Get context-sensitive on-line help:  Acrobat Reader help,
                                      plub-in help (Using Acrobat search), about Acrobat Reader,
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                                      about plug-ins.

FOR DETAIL MENU DESCRIPTIONS SEE THE ADOBE
ACROBAT REFERENCE MANUAL

MENU NAVIGATION TIP:

Select WINDOW/Welcome.pdf to return immediately to the Information
Contents of the welcome file (i.e., the list of available publications) from
anywhere in the document.

If all files have been closed, perform a File/Open/Welcome.pdf

F.  ACROBAT READER WITH SEARCH PROGRAM FUNCTIONS:
                 TOOLBAR

The toolbar contains tools for selecting and viewing documents.  Select a tool
by clicking the tool icon.

The toolbar contains the following tools and buttons:

  A--Click the Page Only button to view only the document.

  B--Click the Bookmarks and Page button to open the overview
area and display
bookmarks created for the document. Click a bookmark’s name to
go to the location marked by that bookmark.  When a document is
first opened, the screen is split into two sections. The left section contains
bookmarks.

  C--Click the Thumbnails and Page button to open the overview
area and display thumbnail images of each document page. Click a
thumbnail to go to the page marked by that thumbnail.
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  D--Use the hand tool to move a document page on-screen when
it does not fit within the window. Drag the hand tool in the
direction you want to move the page.

   E/F--Use the zoom tools to magnify or reduce the page
display by a factor of 2.

 G--Use the select text tool to select text in a document, which
can then be copied to the Clipboard by using the Copy command.
Choose Select Graphics from the Tools menu to select graphics in a
document.

   H/K--Use the First Page or Last Page button to move the
document to the first or last page of a document.

   I/J--Use the Previous Page or Next Page button to move the
document backward or forward, one page at a time.

  L/M--Use the Go Back and Go Forward buttons to retrace
your steps in a document, moving to each view in the order visited.

  N--Click the Actual Size button to display the page at 100 %.

 O--Click the Fit Page button to scale the page to fit within the
window.

 P--Click the Fit Width button to scale the page to fill the width
of the window. Pressing this button fills the window with only the
visible text and graphics on the page.

  Q--Click the Find button to search for part of a word, a
complete word, or multiple words in a document.

 R--SEARCH - This operation (“binoculars on a page” icon) results in a
global text search of all the publications. To move forward and back to
multiple hits in a document, use Ctrl-U ( the SEARCH NEXT  icon-- U below)
to move forward; use Ctrl-Y (the SEARCH PREVIOUS icon--T below)  to
move backward.
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 S--SEARCH RESULT - This operation (“pie on a page” icon) displays the
results of your global search across all documents.

 T--SEARCH PREVIOUS- This operation (“left arrow on a page” icon)
displays the previous occurrence of a searched term.

 U--SEARCH NEXT - This operation (“right arrow on a page” icon)
displays the next occurrence of a searched term.

 V--inactive.  Click the Web Browser button to start your Web
browser.
G.  INDEXES

The Acrobat Reader with Search software performs searching by using one or
more indexes to speedily identify requested items in all documents to which
the index applies.   These index have been created prior to the manufacture
of this CD-ROM and are not modifiable by the user.

The appropriate indexes are pre-set on the CD-ROM,  but a user might
change references to them.  The figures below show the desired appearance of
each Index Selection box when accessing the respective information or
publication.   To view these indexes, click  the Search icon (R), which displays
the Adobe Acrobat Search dialog box.  Clicking on the Indexes box  displays
the Index Selection dialog box and shows the indexes available and selected
for searching on the CD-ROM.
The above information on Acrobat Reader indexes does not apply to the CD
Answer software, but it does apply to the CD Answer Reference Manual,
which is accessed using the Acrobat Reader with Search software by clicking
on its icon in the Encyclopedia of Medical Program Data Windows Group.

The following figures illustrate the appearance of the  search indexes.  They
may be accessed and changed if necessary by placing an x in the appropriate
square; however, most of the indexes listed have been disabled.

ENCYCLOPEDIA OF MEDICAL PROGRAM DATA CD-ROM INDEXES



20

ENCYCLOPEDIA OF MEDICAL PROGRAM DATA
   USER MANUAL INDEXES
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ENCYCLOPEDIA OF MEDICAL PROGRAM DATA
   ADOBE ACROBAT REFERENCE MANUAL INDEXES
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ENCYCLOPEDIA OF MEDICAL PROGRAM DATA
   CD ANSWER REFERENCE MANUAL  INDEXES
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H.  APPLICATION FUNCTIONS

1.  SCAN INDIVIDUAL DOCUMENTS

Double click on the document to be read from the Information Contents list.
Use the bookmark to randomly access a part of the document or use the scroll
arrow or  page up/page down keys to read the document sequentially.

2.  SEARCH TEXT

a.  Search individual documents

Use keyboard keys (e.g., Page Up, Page Down, etc.) to read a document
sequentially.  To find occurrences of specific words in the text, use the FIND
icon (Q) in the Acrobat Reader with Search Toolbar.  To view successive hits
within the document, click the Find Again button.

b.  Global searches (all documents)

The  Search icon (R, “binoculars on a page”) invokes a global text search of all
the text documents on the CD-ROM.   To move forward and back to multiple
hits in a document, use the SEARCH NEXT icon--U (or Ctrl-U) to move
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forward; use the SEARCH PREVIOUS icon--T (or Ctrl-Y)  to move backward.
This process accesses succeeding or preceding documents for which hits are
found.

The following items are available using Acrobat Reader with Search; the 3-
character acronym is used below to identify in which documents search hits
were found in samples below illustrating searching:

1.  DAF--Data Architecture Form Contents (Vol. 10-11)
     DAI--Interview Notes
2.  SPL--AAM Strategic Plan
3.  MGL--Medical Guideline Letters (MGLs)
4.  AMG--Aviation Medical Examiner Guide (Includes Part 67)
5.  FSB--Federal Air Surgeon's Bulletin (1992-1996)
6.  NXR--Index of OAM Reports (1961-1996)
7.  TEL-- OAM Telephone Directory
8.  ORD--AAM Orders and Directives
9.   RED--OAM Research (RED) Program Book
10. NXI-- Index of International Publications in Aerospace Medicine
11. ASH--Aeromedical Certification Division Statistical Handbook (Thru
1994)12. FAR--Federal Aviation Regulations (FARS- Parts 61, 67, 121, 135)
13. AIS--Aviation Industry Substance Abuse Prevention Programs

The following are sample searches and their results.  Reference  details
useful in performing  various searches (e.g., Boolean combination of search
terms) are found in the SEARCH ONLINE GUIDE available through the
Help menu of the Acrobat Reader with Search software package in this CD-
ROM, extracted portions of which information are presented below.

SAMPLE GLOBAL SEARCHES:

What information would help in determining whether a pilot with the following
conditions may be medically certified to fly?

  SEARCH:  Monocular Vision

RESULT:  MGL 88
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What  information would help in determining whether a pilot with the following
conditions may be medically certified  to fly?

SEARCH: AIDS OR  HIV

RESULT: 37 Documents, including the following:

FSB 93-4 (Winter, 1993) :  John D. Hastings, MD, :"Human immunodeficiency
virus (HIV) in the aviation environment, with emphasis on neurologic
considerations"
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To examine a specific document satisfying the search query, double click the
desired document in the Search Results box and use the Search Next (U) or
Search Previous (T) icons.  Close the Search Results window if it is
obstructing the view of the document.  To restore the Search Result window,
click the Search Result icon (S).
The following figure shows hits on AIDS and HIV in the AME Guide:
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c.  Starting a search

1.   Choose Search > Query from the Tools menu, or click the Search
button (R) on the toolbar.

2.   Choose one or more of the following options:

• Enter a search term, phrase, or Boolean expression.

• Choose one or more search options.

3.   Click Search to perform the search. Acrobat Reader  and displays a list of all
the found documents in the Search Results window.

4.   View the search results. By default, the documents returned from a search are
listed according to a score (or relevance ranking), which places the documents
most likely to contain relevant information at the top of the list. Double-click a
document title to display the first page that contains a search term in that
document. With one of the documents returned from the search displayed, you
can use the Search Next (U) and Search Previous buttons (T) to see all the pages
containing search terms in all the documents returned from the search.
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After performing a search, you can use the Refine feature to perform another
search that is limited to just those documents returned by the previous search.

d.  Using the Refine Search feature

Refine search restricts the next search to only those documents found by the
previous search. Only documents currently listed in the Search Results window
are searched.

To use the Refine Search feature:

1.   Use any combination of search terms, and search options to perform a
search. The found documents are listed in the Search Results window.

2.   With one or more documents in the Search Results window, click the Search
button in the toolbar to open the Acrobat Search window.

3.   Enter any new combination of search terms  and search options.

4.   Press Ctrl  and click the Refine button. (Pressing Ctrl with documents in the
Search Results list changes the Search button to the Refine button.) The Search
Results window lists documents that were previously in the Search Results list and
that meet the new search criteria.

III.  DATABASE (FIXED FIELD)  SEARCHING:  DATAWARE
       CD ANSWER

REFERENCE:  CD ANSWER REFERENCE MANUAL

A.  INFORMATION CONTENT

The following items are available using CD ANSWER:

1.  Aviation Medical Examiner Directory

2.  AAM Data Element Dictionary

 B.  WINDOWS OPERATIONS

The Windows software is used by clicking on one of the various menu options
available for  functions to locate and view desired information.  Information
is entered into  dialog boxes to execute the various system functions.

C.  CD ANSWER PROGRAM FUNCTIONS
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The following describes the tools used for searching occurrences of database
items and displaying search results:

1.  SEARCH

a.  SEARCH WINDOW MENUS

The search menus have the following functions:

Search Window Menu Bar

When you open an application, the system automatically opens a Search Window, where you enter your
search information.   See the screen below.

 The Search Window Menu Bar has the following items:

Th Search Window Menu Bar choices are explained in more detail in the CD ANSWER REFERENCE
MANUAL.
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                File                        Open and close applications, perform
                                               print and export operations, load and
                                               save queries, load and save
                                               print/export settings, About CD Answer,
                                               and exit the program.

                Edit                        Cut, paste and copy operations
                                               clear query, clear rectangle,,
                                              and connection operations.

                Options                  Open a search, or display
                                               window, or change screen formats.

                Browse                  Browse  items.

                Data                     Evaluate a search using the current
                                             search strategy, and create and
                                             activate a display window.  Use this
                                             option to perform the search and to
                                             display the results of the search.

                Window               Perform windows operations.

                Help                    Get context-sensitive on-line help.

The Search Window Menu Bar choices are explained in more detail in the CD ANSWER REFERENCE
MANUAL.

b.  SEARCH WINDOW TOOLBAR

The toolbar contains tools (icons) for selecting and viewing database records.
Select a tool by clicking the tool icon.  To hide or show the toolbar, choose
Hide Toolbaror Show Toolbar from the Window menu.

The search window toolbar contains the following tools and buttons:

  Search Window Tool Bar

  
                In addition to using the Menu Bar items to perform operations
                in the Search Window, you can use the Search Window Tool Bar
                icons to execute the most common operations.

                The icons and their corresponding menu options are, from left
                to right:
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                  A--Question Mark                On-line help.

                  B--Folder                              File/Open Application

                  C--Hand/Narrow List            Browse index terms for a  field

                  D--Hand/Wide List             Browse index terms for a  field

                  E --Greek Sigma                   Data/Evaluate--Perform a Search

                  F--Double Column List       Data/Display

                  G--Disk/Right Arrow          File/Load Query

                  H--Disk/Left Arrow           File/Save Query As

                  I--Erase Page                    Edit/Clear Query

                 J--Erase Line                  Edit/Clear Rectangle

                K--Circles                           Connection --insert logical operators into the queries

                  L--Windows Stack             Window/Cascade

                  M--Windows Separate        Window/Tile

                  N--Printer 2+                  File/Print (not available in Search Window)

                  O--Printer 1                    File/Print One (not available in Search Window)

                  P--Scissors                     Edit/Cut (not available in Search Window)

                  Q--Paper Stack              Edit/Copy (not available in Search Window)

                  R--Clipboard                Edit/Paste
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2.  DISPLAY

a.  DISPLAY WINDOW MENUS

The display menus have the following functions:

Display Window Menu Bar

The Display Window Menu choices are explained in more detail in the CD ANSWER REFERENCE
MANUAL.

                After you have entered your search request and executed the
                search, you can display the resulting item that meet the search
                criteria.

                 The list format displays each document in abbreviated format.
                The cursor is positioned on the first document in the found
                set.

                Use the scroll bar on the left of the screen or the
                UpArrow and DownArrow keys or PgUp, PgDn, Home,
                or End to move the cursor through the list of found
                items.  To display an individual item from the list in
                full display screen format, position the cursor on the document
                and select Full from the View menu or press Enter.

                If there is only one item in the found set, the retrieval
                software will display the document in full display screen
                format automatically.

                In a full display screen, use the right scroll bar to scroll
                through an individual item, or the left scroll bar to
                scroll through the entire found document set.

                The Display Window Menu Bar has the following options:

                File                          Open and Close, Print, Print One, Print Setup and
                                                Export options.

                Edit                         Cut, paste and copy operations.

                Options                   The Display option and Notes and Bookmarks are active.

                View                       Changes the display screen,
                                               enables you to sort and unsort
                                               found documents, enables you to
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                                               jump to a specific document, and
                                              enables you to select documents.

                Links                    Inactive

                Window               Perform windows operations.

                Help                    Get context-sensitive on-line help.

                The Display Window Menu  choices are explained in more detail in the CD ANSWER
REFERENCE MANUAL.

                      To return to the display window, use the display icon (item F in the Search Window Tool
Bar above).

b.  DISPLAY  WINDOW TOOLBAR

The display window toolbar contains the following tools and buttons:

Display Window Tool Bar

                On the Display Window Tool Bar, the icons and their
                corresponding menu options are, from left to right:

                  A--Question Mark              On-line help.

                  B--Folder                            File/Open Application

                  C--Right/Left Arrow            Toggle View/Full and View/List

                  D--Eyeglasses                     Go to Search Window

                  E--Camera                           Links/Image--Inactive

    F--Notepad                         Notes/Book marks

                  G--Papers Stack                  View/Sort

                   H--Papers Separate          View/Unsort

      I/J                          Moves the searched term to the top of the
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                            left/right triangle    display  screen

                  K--Up Arrow                       Go to first document

                  L--Up Double Arrow             Page up through documents four at a
                                         time

                  M--Down Double Arrow     Page down through documents four at a
                                                                       time

                  N--Down Arrow                  Go to last document

                  O--Windows Stack              Window/Cascade

                  P--Windows Separate        Window/Tile

                  Q--Printer 2+                     File/Print

                 R--Printer 1                       File/Print One

                  S--Scissors                       Edit/Cut

                  T--Paper Stack               Edit/Copy

                  U--Clipboard                 Edit/Paste (not available in Display
                                                                  Window)

D.  APPLICATION FUNCTIONS

1.  AVIATION MEDICAL EXAMINERS (AMEs)

a.  SEARCH

(1)  SEARCH SCREEN

The Search Screen (shown below) contains rectangles for all searchable fields
for the database.  When the cursor is placed in a particular field, click the
hand/narrow list icon (search window toolbar item C) and the index for that
field appears.  This list may be used by typing words in which you have an
iterest or simply browsing the index to see what is available.
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Browsing the Search Index

You are viewing all the terms in the index for this search field. You can use any of the normal
movement keys (ARROW, PGUP, END, and so on) to move through the list.

You can also search for a particular term by typing it.  The system will automatically move
down the list as you type.  You can use BACKSPACE to correct any typing errors.

To copy the highlighted term into the search field, press ENTER.

To exit the browse window without copying a term, press ESC.

To select multiple browse terms at one time, use CTRL left mouse button to highlight each term
you want.  Use the Select All option to select every term.  To deselect all terms, use Deselect
All.  The Browse options menu enables you to choose the connector for the terms you
choose.  For example, if you want to search for one term AND another term, you would use
the AND connector.  The default connector within the same search rectangle is OR.

Once one or more search rectangles contain words/terms to be searched, click
the search screen  search icon (E) on the search screen tool bar to obtain the
results of the search.  Note that when more than one rectangle is filled in, the
effect of the search is to perform AND operations between the fields.  Then
click the double columns icon on the search screen tool bar to see the list of
the AMEs selected from the search. Select one AME, click on the right/left
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arrow to toggle (icon C on the display tool bar) to display all fields for a
particular AME.  Click the same icon again to return to the list of AMEs just
selected.

SAMPLE SEARCH:

1.  How many AMEs named Jones are there in in the entire AME database?

All AMEs:    23

(2)  FORMULATING SEARCH QUERIES

                After starting CD Answer for Windows  the Search Window appears.  This window contains  the
default search screen for the application and the Search Window Menu Bar at the top of the screen.  The
title in the title bar of the Search Window is the name of the search screen.   This  describes how to enter
search criteria in a search screen.

                The cursor is located at the beginning of the first search  rectangle.  A search rectangle is the
area on the screen where search requests are entered in CD Answer for Windows.
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                You can move between search rectangles in the search screen by clicking on a rectangle (or by
using the UpArrow, DownArrow keys or PgUp,PgDn.  A scroll bar on the rightmost border of the search
screen indicates whether there are search rectangles above or below the visible screen.

                To search for an item in the database, you enter a valid search request into one or more search
rectangles.  A valid search request contains one or more search terms, where a  search term can be a
word or a string.  Multiple search terms  may be separated by logical operators, proximity operators, or
blanks.  A search request may also contain truncation symbols, parentheses, or quotation marks.  Each of
these search elements is described in the subsections below.

For a complete description of logical operators proximity operators, truncation symbols and  ranges and
phonetic searches see the CD ANSWER REFERENCE MANUAL.

b.  DISPLAY SCREENS

Selecting the double column list icon from the search windows toolbar (Item F) produces
the following screen:

Selecting one individual AME and double clicking on the left arrow toggle
icon (Item C in the Display Window toolbar) results in the following display:
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2.  AAM DATA ELEMENT DICTIONARY

a.  SEARCH SCREEN

The menu bar and toolbar and the search procedures are the same as
described above for the AME application.

The following figure shows the index for the AAM Data Element Dictionary
for the element name field:



40



41

SAMPLE SEARCH:

1.  Does AAM capture data on accidents? Yes

ACCIDENT ASSOCIATED-EIR, etc.
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b.  DISPLAY SCREEN
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